
 
 

 
 

 
 
 

SOUTH BRONX ENVIRONMENTAL HEALTH AND POLICY STUDY 
 
 
 

 
 

 
 
 

Dissemination Materials and Geographic Information Systems (GIS) Tutorial Materials 
 
 

Final Report for Phase VI 
April 2009 

 
 
 
 
 

Institute for Civil Infrastructure Systems (ICIS) 
Robert F. Wagner Graduate School of Public Service 

New York University 
295 Lafayette Street 

New York, NY 10012 
(212) 992-ICIS (4247) 

www.nyu.edu/icis 
 
 

Edited by Carlos E. Restrepo and Rae Zimmerman 
 
 
 

Funded with a Congressional Appropriation sponsored by Congressman José E. Serrano and 
administered through the U.S. Environmental Protection Agency 



ACKNOWLEDGMENTS AND DISCLAIMER:  
 
Phase VI of the South Bronx Environmental Health and Policy Study is funded with a 
Congressional Appropriation sponsored by Congressman José E. Serrano and administered 
through the U.S. Environmental Protection Agency under grant number X982152-06 to New 
York University. The views expressed in this report are those of the author(s), and do not 
necessarily reflect the views of the U.S. EPA. 
 
The NYU-Wagner-ICIS team thanks the generous support of Congressman José E. Serrano and 
Paul Lipson, Cheryl Simmons-Oliver, Siddhartha O. Sanchez and other members of his staff, and 
John Filippelli, Kirk Wieber, Gavin Lau and others at the U.S. EPA who provided valuable 
comments on our work. At NYU, Alicia D. Hurley, and Jessica Clemente provided invaluable 
support. We thank members of the project team from the four South Bronx Community Groups 
(The Point Community Development Corporation, We Stay/Nos Quedamos, Sports Foundation 
Inc., and Youth Ministries for Peace and Justice Inc.) for their guidance and support.  

 2



 
TABLE OF CONTENTS 

 
           Page 
 
I. Introduction          4 
 
 
II. Summary Papers for Dissemination      6  
            

• Air Quality in the South Bronx     7 
• Asthma in Bronx County      11 
• Proximity of Schools to Highways and Other     

Sources of Environmental Health Risks    14 
• Public Policy Recommendations     18 

 
 
III. GIS Tutorial Materials        23 
 
 
 

 3



I. Introduction 
 
The main objective of the NYU Wagner component of Phase VI of the South Bronx 
Environmental Health & Policy Study is to produce materials for dissemination related to the 
project and its findings. This phase complements Phase V which was related to various outreach, 
education and dissemination activities, documented in the Phase V report, as well as earlier 
phases of the Study. The summary documents presented in this report are drawn from research 
material produced throughout the Study. This objective was accomplished by updating and 
writing several summary documents which are included in this report. In addition, a Geographic 
Information Systems (GIS) tutorial was developed for the participating community groups and 
GIS software was obtained for them. 
 
The goal of the GIS tutorial and software is to provide the community groups with an analytical 
tool so that they can continue to analyze environmental and health problems in their communities 
and to use the information in their environmental planning and policy advocacy efforts. 
Transferring this knowledge to the participating community groups will also give the work of the 
South Bronx Environmental Health and Policy Study greater longevity since it will allow the 
community groups to continue working on these issues after the project officially ends. 
 
The development of a GIS tutorial and updating of the GIS software follows from previous 
project activities. Geographic Information Systems (GIS) is an important capability to analyze 
spatial relationships among environmental and social characteristics of the South Bronx 
community. In June and July of 2006 the NYU-Wagner team held six GIS workshops with the 
community groups. Each community group was invited to participate with up to two members of 
their staff. The focus of the workshops was environmental health and other relevant information 
from Bronx County and GIS was used to display this information and to use it as a tool for 
analysis. These workshops were organized and conducted by Zvia Segal Naphtali and are 
described in the Phase V report.  
 
Four summary papers were prepared as part of Phase VI of the project in the following areas: 
 

• Air Quality in the South Bronx 
• Asthma in Bronx County 
• Proximity of Schools to Highways and Other Sources of Environmental Health 

Risks 
• Public Policy Recommendations 

 
In addition, at the concluding date of the project an academic paper titled “Proximity of Schools 
to Highways and to Environmental Health Risks: A Comparative Study” is being submitted to a 
journal for publication. 
 
The main vehicle for the dissemination of the NYU-Wagner component of Phase VI of the 
project will be the project web page: http://www.icisnyu.org/south_bronx/index_001.html
 
The section of the web page titled reports will include the four summary project documents and 
the GIS tutorial materials described in this report. As mentioned previously, the GIS tutorial 
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materials were developed for the community groups and along with a copy of the latest version 
of ArcGIS software they will be provided with a CD containing the data needed to go through 
the tutorial lessons. The data consists of publicly available data related to transportation and 
other issues in Bronx County.  
 
Future Research Directions 
 
As the South Bronx Environmental Health and Policy Study comes to an end important research 
questions remain. The relationships between transportation, waste management, air quality, land 
use and asthma are extremely complex and pose many important research challenges. The NYU-
Wagner team will try to continue research in the area of proximity of schools and other sensitive 
areas to highways and major roads.  
 
The research issue to be addressed in this area is to determine whether there are statistically 
significant associations between proximity to risk factors (i.e., high traffic volume intersections 
and waste transfer stations) and incidence and prevalence of asthma among primary school 
children. Following the research approach that the NYU-Wagner team has followed as part of 
this study, this kind of analysis would require obtaining information about asthma symptoms and 
morbidity including rates of visits to the school nurse for asthma and school absenteeism due to 
asthma. Unfortunately this information is not currently being systematically collected and 
addressing this research question would require working with a sample of schools in the South 
Bronx and developing protocols for the collection of such data at the school level. Future efforts 
in this direction could significantly help researchers, urban planners and policy makers advance 
knowledge in this area.  
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II. Summary Papers for Dissemination  
 
Four summary papers for dissemination related to the South Bronx Environmental Health and 
Policy Study are included in this section of the report. They include: 
 
1. Air Quality in the South Bronx 
 
2. Asthma in the South Bronx 
 
3. Proximity of Schools to Highways and Other Sources of Environmental Health Risks 
 
4. Public Policy Recommendations 
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Summary Paper #1: Air Quality in the South Bronx 

 
What is air pollution? 
 
A pollutant is a substance (gas, liquid or solid) that is harmful to people, animals or plants. By 
coming into contact with them, pollutants can make the air, water and soil around us harmful. 
Some examples of air pollutants are: carbon monoxide (CO), ozone (O3), nitrogen dioxide 
(NO2), sulfur dioxide (SO2), and particulate matter (PM).1 These are common air pollutants 
found in urban areas and they are measured on a regular basis by monitoring stations. 
 
Carbon monoxide (CO) is a colorless gas or liquid, and is practically odorless. The main sources 
of CO are unvented kerosene and gas space heaters, leaking chimneys and furnaces, gas water 
heaters, wood stoves, fireplaces, gas stoves, automobile exhaust, and tobacco smoke. At low 
concentrations, CO results in fatigue in healthy people and chest pain in people with heart 
disease. At higher concentrations, the effects are impaired vision and coordination, headaches, 
dizziness, confusion and nausea. This pollutant is fatal at very high concentrations. 
 
Ozone (O3) is an odorless, colorless gas composed of three atoms of oxygen. Ozone occurs 
naturally in the Earth’s upper atmosphere, between 10 and 30 miles above the Earth’s surface. At 
that height it forms a protective layer that shields us from the sun’s harmful ultraviolet rays. 
However, O3 is also formed near ground level, when pollutants emitted by cars, power plants, 
industrial boilers, refineries, chemical plants, and other sources react chemically in the presence 
of sunlight. Ozone in the lower atmosphere is harmful to humans and is linked to many health 
problems, including irritation of the respiratory system, reduced lung function, aggravation of 
asthma, and damage to the lining of the lung. 
 
Nitrogen dioxide (NO2) along with particles in the air can often be seen as a reddish-brown layer 
over many urban areas. The main sources of NO2 are motor vehicles, electric utilities, and other 
industrial, commercial, and residential sources that burn fuels. Short-term exposure to NO2 may 
cause increased respiratory illness in young children and harm lung function in people with 
existing respiratory illnesses. Long-term exposure may lead to increased susceptibility to 
respiratory infection and may cause alterations in the lung.  
 
Sulfur dioxide (SO2) is formed when fuel containing sulfur (mainly coal and oil) is burned, and 
during metal smelting and other industrial processes. The major health concerns associated with 
exposure to high concentrations of SO2 include effects on breathing, respiratory illness, 
alterations in pulmonary defenses, and aggravation of existing cardiovascular disease. Children, 
the elderly, and people with asthma, cardiovascular disease or chronic lung disease (such as 
bronchitis or emphysema), are most susceptible to adverse health effects associated with 
exposure to SO2. 
 
Particulate matter (PM10 and PM2.5): Particulate matter is the generic term used for air pollution 
that consists liquid and solid particles suspended in the air. High concentrations and/or specific 
types of particles have been found to be dangerous to human health. Particulate pollution comes 
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from many sources, including factory and utility smokestacks, vehicle exhaust, wood burning, 
mining, construction activity, and agriculture. Particles of special concern are those known as 
fine particles, less than 2.5 microns in diameter (for comparison, a human hair is about 75 
microns in diameter). Fine particles are easily inhaled deeply into the lungs where they can be 
absorbed into the bloodstream or remain embedded for long periods of time. Particulate matter 
air pollution is especially harmful to people with lung disease such as asthma and chronic 
obstructive pulmonary disease (COPD), which includes chronic bronchitis and emphysema, as 
well as people with heart disease.  
 
How do we know when air pollution is a serious problem? 
 
Given what is known about pollutants and their effect on human health, maximum acceptable 
levels for pollutants are defined by the U.S. Environmental Protection Agency (EPA) as part of 
the National Ambient Air Quality Standards (NAAQS).2 These values are known as air quality 
standards. Concentrations above the standards are considered harmful to human health and 
policies are aimed at keeping pollution concentrations below these levels. Standards are available 
for the pollutants described above.  
 
Air pollution standards are usually given in units of ppm and µg/m3. These units refer to the 
concentration of air pollutants - ppm stands for “parts per million”, and µg/m3 stands for 
“micrograms per cubic meter”. Standards are normally compared to an averaging time. For 
example, the environmental standard for NO2 set by the Environmental Protection Agency 
(EPA) is an annual average of 0.053 ppm. This means that hourly measurements of NO2 
concentrations are averaged over a period of one year. If the resulting average is above the 
standard concentrations of this pollutant are considered to be harmful to human health. Other 
pollutants, such as CO and O3 have standards for averaging periods as short as one hour.    
 
Although adverse health effects are observed for concentrations below the standards established 
by EPA, these concentrations are considered “acceptable”. But our knowledge about these 
pollutants and their impact is constantly improving and every five years the standards are subject 
to revision and could be made more stringent over time.  
 
What Is the South Bronx Environmental Health and Policy Study? 
 
In 1999, Congressman José E. Serrano engaged NYU’s School of Medicine, Robert F. Wagner 
Graduate School of Public Service, and four community groups (The Point Community 
Development Corporation, The Sports Foundation, Inc., We Stay/Nos Quedamos, Inc., and 
Youth Ministries for Peace and Justice, Inc.) in a collaborative effort to better understand the 
relationships between environmental quality and health issues such as asthma that are important 
to the South Bronx community. The project is funded by the U.S. Environmental Protection 
Agency (EPA).3
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What has the South Bronx Environmental Health and Policy Study found 
about Air Quality in the South Bronx? 
 
Hourly concentrations of the pollutants described in this document are available from several 
monitoring stations in the study area operated by the New York State Department of 
Environmental Conservation (DEC)4. In an early phase of this project data were analyzed for the 
period 1996-2000. The results indicate that CO, SO2 and NO2 are well below the EPA standards. 
PM2.5 and O3 occasionally register concentrations that exceed the standards.  
 
This project has also collected new air quality data using a mobile laboratory placed in a van. 
This lab is operated by NYU’s Nelson Institute of Environmental Medicine. One of the concerns 
voiced by community members in the initial stages of the study was that DEC’s monitoring 
stations are located on school rooftops, about 15 meters above ground. Because people breathe 
air much closer to ground-level, they expressed an interest in measuring air quality at a lower 
height. The air intake of the mobile van is about 4 meters above the ground and the data 
collected with it were compared with DEC’s data for the same time periods when the van was 
taking samples. 
 
The findings indicate that for PM2.5 the ground-level measurements are similar in value and trend 
with those of DEC stations. In the case of O3, the concentrations recorded close to ground level 
by the project’s mobile van were generally lower than those recorded by DEC stations. For the 
other pollutants the concentrations measured by the project were substantially higher than those 
recorded by DEC's monitoring stations. For NO2 the daily average concentrations recorded by 
the van were over twice as high as those recorded by DEC stations. If the van's data are 
representative of concentrations of NO2 in the area for the whole year, EPA's annual standard 
would be exceeded. In the case of SO2, ground level measurements recorded by the project's van 
are also substantially higher than DEC measurements. However, the van's measured 
concentrations as well as DEC's data suggest concentrations that are well below EPA's 24-hour 
average standard for SO2. Similarly, CO concentrations measured at ground level tend to be 
higher than those recorded by DEC's stations. As with ozone, 1-hour average maximum values 
were selected each day in order to compare the data with EPA's 1-hour standard. Both the 
project’s mobile lab and DEC's measurements suggest concentrations of CO that are well below 
EPA's standard. 
 
The most significant difference between the van’s measurements and the DEC data appears to be 
for NO2. EPA has set a one-year standard for this pollutant. This means that one year’s worth of 
data would have to be collected close to ground level to compare it to the standard. Because 
ambient NO2 concentrations do not show strong seasonal variations, these preliminary results 
suggest that more monitoring of NO2 concentrations close to ground level should be carried out 
in order to ensure that the standard is not being exceeded. Current federal regulations indicate 
that monitoring stations can be located at heights between 2-15 meters and it would be valuable 
to obtain more information about the vertical profile of this pollutant to ensure that residents in 
the area are not being exposed to dangerous levels of NO2.5   
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Summary of project findings about air quality 
 

• Hourly concentrations of Elemental Carbon—a component of diesel exhaust from 
trucks—were higher at all South Bronx sites than those at Manhattan sites. In Hunts 
Point, these concentrations were significantly higher than in other parts of the Bronx.6  

• Car exhaust, burning fuels, and heavy industry are producing higher ground-level 
concentrations of some pollutants, like CO, NO2, and SO2, in the South Bronx as 
compared to rooftop monitoring station samples.  

• Local and regional air pollution from cars, power plants, construction activity, and other 
chemical processes are producing high concentrations of O3 and PM2.5 in the South Bronx 
at levels that sometimes exceed U.S. EPA standards.  

• While urban environments generally contain a presence of NO2 in the air—as a result of 
many industrial, commercial, and residential sources—samples from the NYU mobile 
van in the South Bronx were higher than scientists expected. The study recommends that 
DEC should perform more ground-level monitoring of NO2. 

 
1 Additional information about these common air pollutants is found in: http://www.epa.gov/air/urbanair/ 
2 For a more detailed description of the National Ambient Air Quality Standards (NAAQS) see: 
http://www.epa.gov/ttn/naaqs/ 
3 To learn more about NYU-School of Medicine component of the project visit http://www.med.nyu.edu/SBEHPS// and to 
learn  more about  the NYU-Wagner component of the project visit http://www.icisnyu.org/south_bronx/index_001.html  
4 See New York State Department of Environmental Conservation (DEC), Ambient Air Quality Monitoring 
New York's Program to Track Air Quality, http://www.dec.ny.gov/chemical/8406.html 
5 These findings are explained in more detail in Chapter 2 of the NYU-Wagner Phase II and III project report, which 
is available online: http://www.icisnyu.org/south_bronx/admin/files/ICISPhaseIIandIIIreport.pdf  
6 More information about the NYU-School of Medicine component of the project is available at: 
http://www.med.nyu.edu/SBEHPS//  

http://www.med.nyu.edu/SBEHPS//
http://www.icisnyu.org/south_bronx/index_001.html
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Summary Paper #2: Asthma in Bronx County  

 
What is asthma? 
 
Asthma is a respiratory disease characterized by bronchial hyper-responsiveness, bronchial 
constriction, airway inflammation and recurrent airflow obstruction. It is accompanied by 
respiratory symptoms such as wheezing, dyspnea, coughing, and chest tightness. The 
development of asthma is multi-factorial, and is currently poorly understood. Among the risk 
factors and triggers for asthma are genetic predisposition and environmental factors such as 
allergen exposure, environmental tobacco smoke, socioeconomic status, nutrition, low birth 
weight, history of infections, and ambient levels of air pollution.1   
 
Asthma in Bronx County 
 
Bronx County has some of the highest rates of asthma in the United States. Rates of death from 
asthma are about three times higher in the Bronx than the national average. Hospitalization rates 
are about five times higher. In some neighborhoods in the Bronx it is estimated that 20% of the 
children have asthma.2

 
As the following graph shows, Bronx county has the highest pediatric asthma (children 0-4 
years) hospitalization rates in the New York area. New York county (Manhattan) has the second 
highest rate. Richmond county (Staten Island) and Upstate New York, which includes all of New 
York State except New York City, have pediatric asthma hospitalization rates that are 
significantly lower than those of the other counties included in the graph.3
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1 See Pandya, Robert J., Gina Solomon, Amy Kinner and John R. Balmes. "Diesel Exhaust and Asthma: Hypotheses 
and Molecular Mechanisms of Action." Environmental Health Perspectives. Vol. 110, Supplement 1, February 
2002. Pages 103-112. 
2 See Ruppel Shell, Ellen. "Does Civilization Cause Asthma?" The Atlantic Monthly. May 2000. This article can be 
accessed at: http://www.theatlantic.com/issues/2000/05/shell.htm - access date: September 9, 2002. 
3 This graph was constructed using data from the New York State Department of Health.  
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What Is the South Bronx Environmental Health and Policy Study? 
 
In 1999, Congressman José E. Serrano engaged NYU’s School of Medicine, Robert F. Wagner 
Graduate School of Public Service, and four community groups (The Point Community 
Development Corporation, The Sports Foundation, Inc., We Stay/Nos Quedamos, Inc., and 
Youth Ministries for Peace and Justice, Inc.) in a collaborative effort to better understand the 
relationships between environmental quality and health issues such as asthma that are important 
to the South Bronx community. The project is funded by the U.S. Environmental Protection 
Agency (EPA).4

 
What has the South Bronx Environmental Health and Policy Study found 
about Asthma? 
 
The South Bronx Environmental Health and Policy Study has looked at asthma in two ways. The 
first is by directly studying the link between air pollution levels and asthmatic children in three 
local schools. This was accomplished with the “Backpack Study”. The study has also examined 
how asthma hospitalizations vary among different zip codes in the Bronx and how these 
variations are related to factors such as poverty, race and the presence of industrial facilities. 
 
The Back-Pack Study 
 
The NYU School of Medicine conducted a study on the impact of air pollution on children with 
asthma called the “Backpack Study” in several local schools. The study worked with fifth  
Grade students who carried backpacks equipped with devices to measure the air pollution they 
are exposed to in their everyday lives. The data were then analyzed and compared to asthma 
symptoms recorded by the students in diaries. Ten students from three South Bronx elementary 
schools were asked to spend three weeks with the backpacks.  
 
Asthma Hospitalizations, Race, Poverty and Industrial Facilities 
 
An examination of asthma hospitalizations in Bronx County using data compiled by the New 
York State Department of Health indicates that: 
 

• Asthma hospitalization rates are highest in the central and southern parts of Bronx 
County, especially in zip codes 10457, 10451, 10454 and 10456. 

 
• There is a strong association between asthma hospitalization rates, poverty, the 

percentage of Hispanic residents, and the number of industrial facilities in the Bronx.  
 

• Higher asthma hospitalization rates are more likely to occur in lower-income areas of the 
South Bronx and in areas where there is a large presence of Latino/Hispanic residents.  

 
4 To learn more about NYU-School of Medicine component of the project visit http://www.med.nyu.edu/SBEHPS// and to 
learn  more about  the NYU-Wagner component of the project visit http://www.icisnyu.org/south_bronx/index_001.html

http://www.med.nyu.edu/SBEHPS//
http://www.icisnyu.org/south_bronx/index_001.html
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• There is a strong association between Bronx zip codes with high asthma rates and those 

with a large concentration of industrial facilities. 
 
The map below shows Bronx County Asthma Hospitalization Rates per 10,000 people by zip 
code for the year 2000 and how these hospitalizations are related to the density of industrial 
facilities. As the map shows the highest rates of asthma hospitalizations coincide with the highest 
concentrations of industrial facilities in the county. 
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Summary Paper #3: Proximity of Schools to Highways and Other Sources of 
Environmental Health Risks 

 
Wagner Graduate School of Public Service/ Institute for Civil Infrastructure Systems 

(ICIS) 
New York University 

 
The main goal of the South Bronx Environmental Health and Policy Study is to investigate 
environmental and health issues affecting the South Bronx community, with particular emphasis 
on the relationships between air quality, transportation, waste transfer activity, demographic 
characteristics, and public health. It is a collaborative research project of the NYU School of 
Medicine’s Nelson Institute of Environmental Medicine (NIEM), the NYU Wagner Graduate 
School of Public Service’s Institute for Civil Infrastructure Systems (ICIS), and four community 
groups: The Point Community Development Corporation, We Stay/Nos Quedamos, Sports 
Foundation Inc., and Youth Ministries for Peace and Justice Inc. 
 
This summary highlights some of the findings of the Wagner School portion of the study. 

 
THE SOUTH BRONX (THE PROJECT’S STUDY AREA), MAJOR HIGHWAYS, WASTE TRANSFER 

STATIONS AND TOXIC RELEASE INVENTORY (TRI) SITES 

 
 
Background Information 
 
The South Bronx has large volumes of heavy vehicle traffic passing through it along major 
highways, creating pollution affecting local residents.   
 

• Industry concentration: Hunts Point Market, private waste transfer stations, etc.  
• Highway concentration: Interstates 87, 95, 278, and 895 

 
The South Bronx is afflicted with very high asthma rates.  
   

• In New York City, 17% of children 17 years and younger—300,000 children—have 
had asthma at some time in their lives. In the South Bronx the figure is 20-30% (NYC 
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Vital Signs, April 2003 Volume 2, No. 4, New York City Department of Health and 
Mental Hygiene). 

 
Transportation and Air Quality Modeling 
 
The Bronx is currently a “non-attainment area” for particulate matter (PM2.5), which means that 
the U.S. Environmental Protection Agency’s current annual standard for this pollutant is 
exceeded.  
 
Past land use planning decisions in the South Bronx have placed this sensitive population in 
close proximity to highways, truck routes, industrial land use areas and other environmental 
hazards. Studies have shown that traffic associated with these facilities exacerbates asthma 
symptoms.  
  
Modeled concentrations of traffic-related particulate matter and nitrogen oxides are two to five 
times higher around South Bronx highways than in other parts of the South Bronx. 
 
Highways, Truck Routes and Proximity to Schools 
 
About a fifth of all pre Kindergarten to 8th grade students in the South Bronx attend schools 
within 150 meters (500 feet or less than two city blocks) of major highways, where air pollution 
concentrations exceed background levels. 
  
DISTRIBUTION OF PEDIATRIC ASTHMA HOSPITALIZATIONS  
PER 1000 CHILDREN BY ZIP CODE 

         
 
According to the literature on traffic and health effects, people within 150 meters of major 
highways or high traffic density roads are exposed to air pollution concentrations that are higher 
than the ambient background concentrations (Hitchins 2000). About a fifth of pre Kindergarten 
to 8th grade students attend schools within 150 meters (500 feet or less than two city blocks) of a 
highway in the South Bronx compared to far less (ten percent) in New York City as a whole. If 
you live in the South Bronx your child is twice as likely to attend a school near a highway as 
other children in the City. 
 



    

 16 
 

 
 
About half of the pre Kindergarten to 8th grade students in the South Bronx attend schools 
located within 150 meters (500 feet or less than two city blocks) of a highway or truck route.  

 
 
Industrial Land Use Areas and Proximity to Schools 
 
About half of all pre Kindergarten to 8th grade public elementary school students in the South 
Bronx attend schools close to industrially-zoned land (within1/8 of a mile or two and a half city 
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blocks) containing waste transfer stations and other facilities associated with high diesel truck 
traffic and pollution emissions.  
blocks) containing waste transfer stations and other facilities associated with high diesel truck 
traffic and pollution emissions.  

  
THE SOUTH BRONX, PROXIMITY OF SCHOOLS, NURSING HOMES AND HOSPITALS TO AREAS 

ZONED FOR MANUFACTURING LAND USES – USING A 1/8 MILE BUFFER 
THE SOUTH BRONX, PROXIMITY OF SCHOOLS, NURSING HOMES AND HOSPITALS TO AREAS 

ZONED FOR MANUFACTURING LAND USES – USING A 1/8 MILE BUFFER 
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Summary Paper #4: Public Policy Recommendations 

 
 
What Is the South Bronx Environmental Health and Policy Study? 
 
In 1999, Congressman José E. Serrano engaged NYU’s School of Medicine, Robert F. Wagner 
Graduate School of Public Service, and four community groups (The Point Community 
Development Corporation, The Sports Foundation, Inc., We Stay/Nos Quedamos, Inc., and 
Youth Ministries for Peace and Justice, Inc.) in a collaborative effort to better understand the 
relationships between transportation, environmental quality and health issues such as asthma that 
are important to the South Bronx community. This document describes the main policy 
recommendations made by the South Bronx Environmental Health and Policy Study.1  
 
 
Science policy recommendation 
 
Monitoring is key to understanding environmental quality risks people face. One of the concerns 
voiced by community members in the initial stages of the study was that the New York State 
Department of Environmental Conservation’s (DEC) monitoring stations are located on school 
rooftops, about 15 meters above ground. Because people breathe air much closer to ground-level, 
they expressed an interest in measuring air quality at a lower height. The air intake of the mobile 
van used in this project for air quality measurements is about 4 meters above the ground and the 
data collected with it were compared with DEC’s data for the same time periods when the van 
was taking samples.  
 
The comparison of DEC and van measurements for the key pollutants yielded a surprising result. 
For nitrogen dioxide (NO2) the daily average concentrations recorded by the van were over twice 
as high as those recorded by DEC stations. If the van's data are representative of concentrations 
of NO2 in the area for the whole year, EPA's annual standard would be exceeded.2

 
Since the current EPA standard for this pollutant is an annual average, a policy recommendation 
is to begin monitoring concentrations of this pollutant at several heights in the study area to 
establish a vertical profile. If concentrations for this pollutant are found to exceed the standard at 
lower heights then more aggressive policies to control this pollutant would have to be 
implemented.3  
 
 
Transportation and air quality policies 
 
Trucks can be a key source of air pollution potentially affecting public health. According to the 
NYU-School of Medicine’s findings as part of this project, hourly concentrations of elemental 
carbon—a component of diesel exhaust from trucks—measured in 2002-2004 were higher at all 
South Bronx sites than those at Manhattan sites. In Hunts Point, these concentrations were 
significantly higher than in other parts of the Bronx.4 In addition, highways were identified as a 
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major source of elemental carbon. Given the health effects of this pollutant, policies in the area 
aimed at reducing air pollution concentrations should be taken. These may include supporting 
initiatives for alternative technologies for public transportation buses and creating more green 
spaces and green buffers, especially around sources of environmental health risks.  
 
Transportation for the Hunts Point section of the South Bronx is part of New York City’s 
stimulus package under the American Recovery and Reinvestment Act (ARRA). In a March 30, 
2009 NYC press release the funded project, titled “Improvements to Hunts Point,” is described 
as follows:5  
“Improvements to facilitate the safe movement of trucks, cars, bicycles and pedestrians 
throughout Hunts Point and integrate the South Bronx into the regional greenway system. The 
project will create a greenway in Hunts Point and Port Morris to help improve air quality, 
encourage recreation and reduce pollution in an area plagued with high asthma and obesity rates.  
The project include the Lafayette Avenue streetscape, Hunts Point Landing waterfront access, 
creating a connection from the South Bronx to the recreational facilities at Randall's Island, Food 
Center Drive transportation improvements, and new complementary greenway improvements.  
Total Project Cost: $48.9 million 
Displaced Funding Received: $22 million 
Other Funding: $16.7 million City Capital Funds, $6.8 million State Funding, $3.4 million 
Federal Funding 
Construction Bid: Spring 2009 
Estimated Completion: Fall 2012” 
 
An important policy implication is to continue to build on this model project, which combines 
transportation and public health issues through the use of creative land use and environmental 
planning, and extend this planning model to other parts of the South Bronx. 
 
The findings of the South Bronx Environmental Health and Policy Study also support policies 
outlined in the New York City Waste Management Plan and currently being implemented.6 
More specifically, the use of marine transfer stations and rail to transport waste around New 
York City and to export it out of the city for final disposal would reduce truck traffic, a major 
source of elemental carbon and other pollutants that affect the health of South Bronx 
communities.   
 
Given truck traffic in general and the manner in which wastes are transported by truck through 
the South Bronx, truck idling is likely to occur at least at traffic signals, during congestion and at 
stops for pickup and delivery. Idling is covered by State Law (N.Y.S. Anti-Idling Law & 
Regulation, Chapter 670 Law of 2007). In New York City the limits were made more stringent 
on February 2009, reducing idling time around schools from three minutes to one minute for 
non-emergency vehicles.7 In the past, enforcement has been identified as a limitation of the 
effectiveness of existing idling legislation. Thus, a key policy recommendation is to strengthen 
enforcement and provide incentives for trucks not to idle. 
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Zoning policies 
 
The results of traffic and air quality simulation scenarios show that important changes in traffic 
flows and concentrations of particulate matter can be achieved by removing sources of traffic 
such as waste transfer stations and by relocating them. Currently some waste transfer stations are 
located in M-2 zoned areas. These buffer areas allow such activities provided they take extra 
measures to reduce their environmental impact. Given the environmental quality issues faced by 
the study area future permits for industrial activities such as waste transfer stations should not be 
allowed in M-2 areas and where possible efforts should be made to relocate them to M-1 areas, 
which are further away from residential areas.8  
 
 
Proximity of schools to highways 
 
An increasing body of research has examined the dispersion of air pollutants resulting from 
traffic around highways. A study in Brisbane, Australia measured the concentration of particulate 
matter around highways and found that concentrations within 150 meters of highways are 
significantly higher than background concentrations.9 These concentrations rapidly decrease 
until about 300 meters where concentrations were found to be similar to background 
concentrations. Similar studies have also been conducted around highways in Los Angeles, 
California.10

 
According to the findings of the South Bronx Environmental Health and Policy Study, in the 
South Bronx, an area of New York City that has among the highest asthma prevalence and 
hospitalization rates in New York City, about 20% of pre-Kindergarten to 8th grade students 
attend schools within 150 meters (or two city blocks) of a major highway. The figure for New 
York City as a whole is less than 10%. About half of the pre Kindergarten to 8th grade students 
in the South Bronx attend schools located within 150 meters (500 feet or less than two city 
blocks) of a highway or truck route.11    
 
There are a number of policies and measures that could be implemented to address the 
environmental risks posed the close proximity of many schools in the South Bronx to major 
highways. New York City could adopt measures to limit the distance between the location of 
new schools and major highways. For example, California has implemented a policy that new 
schools cannot be located within 500 feet of the edge of the closest traffic lane of a freeway or 
other busy traffic corridors. For schools that are currently located in close proximity to a 
highway or busy traffic intersection the New York City Department of Education could work 
with the U.S. Environmental Protection Agency to promote the adoption of measures to improve 
indoor air quality such as the existing  Indoor Air Quality Tools for Schools Action Kit 
program.12 Indoor air quality is strongly affected by outdoor air quality and these programs can 
have a significant impact over indoor air quality. There is evidence that the adoption of indoor 
air quality programs by schools leads to fewer asthma attacks, fewer visits to the school nurse, 
and lower student absenteeism.13
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In addition to these school-specific measures, urban planning tools such as greenways and green 
buffers can be used to reduce the impact of air pollution on the residents of urban areas such as 
the South Bronx. Trees have been shown to reduce air pollutant concentrations14 and recent 
studies for New York City provide some evidence that a greater number of trees in an area is 
associated with fewer hospital admissions for young children.15 If tree species are adequately 
chosen they can also benefit other efforts such as reducing temperature and improving 
microclimate and providing habitat for urban species. In addition to targeting specific areas such 
as schools from highways and truck routes, tools such as the New York City 2005-2006 Tree 
Census can be used with GIS to understand where trees could have a significant impact.16 The 
experience of Morrisania with the development of a Community Forestry Management Plan 
could be used in other neighborhoods in the South Bronx.17  
 
 
Integrating PlaNYC Initiatives into South Bronx Policies 
 
PlaNYC is the New York City-wide initiative for sustainability and reinforces some key policy 
recommendations for the South Bronx.18 The PlaNYC effort is continually evolving, but some of 
the key policies that have emerged from it are of considerable significance to the South Bronx. 
Some of these policies are being implemented, according to the PlaNYC Progress Report 2009, 
and include integrated land use approaches such as the Schoolyards to Playgrounds initiative and 
tree planting efforts to address public health issues such as asthma. Similarly, continued efforts 
to improve air quality will have important benefits to the South Bronx community. PlaNYC aims 
to convert boilers to cleaner fuels at over 100 schools in the highest asthma hospitalization areas 
in the city. According to the 2009 PlaNYC progress report, since Earth Day 2008, this type of 
conversion is being carried out at nine schools and has been scoped at another 14.19 This kind of 
policy could use the results of the South Bronx Environmental Health and Policy Study to 
identify priority schools where children may already be exposed to high levels of air pollution, 
such as the schools identified as being in close proximity to highways and major roads. To 
improve air quality around these schools such areas could be designated as high priority areas for 
the MillionTreesNYC (http://www.milliontreesnyc.org/) initiative that is an important 
component of PlaNYC.  
 
The City of New York has also published a wide range of best practices for stormwater 
management (NYC December 2008) that in addition to addressing water issues, provide green 
spaces and air cleansing areas that dilute air pollution as well.20

 
Over the last decade the South Bronx has joined the City with many new initiatives that support 
a sustainable environment through groups such as Sustainable South Bronx 
(http://www.ssbx.org/) and The Point CDC (http://www.thepoint.org/). A key policy issue is how 
to promote, finance, and sustain the continuity of these efforts. 
 
 
                                                 
1 To learn more about NYU-School of Medicine component of the project visit http://www.med.nyu.edu/SBEHPS// and to 
learn  more about  the NYU-Wagner component of the project visit http://www.icisnyu.org/south_bronx/index_001.html

http://www.milliontreesnyc.org/
http://www.ssbx.org/
http://www.thepoint.org/
http://www.med.nyu.edu/SBEHPS//
http://www.icisnyu.org/south_bronx/index_001.html
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Martin Blaustein and Lung Chi Chen. 2004. “A comparison of ground-level air quality data with New York State 
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4 See Polina B. Maciejczyk, John H. Offenberg, Jessica Clemente, Martin Blaustein, 
George D. Thurston and Lung Chi Chen. 2004. “Ambient pollutant concentrations measured by a mobile 
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6 The New York City Department of Sanitation’s Comprehensive Waste Management Plan is available online: 
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7 See Kowalski, Tara. 2009. “New York City strengthens anti-idling laws, reflecting nationwide trend of state and 
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9 See Hitchins, J., L. Morawska, R. Wolff, and D. Gilbert. 2000. "Concentrations of Submicrometer Particles from 
Vehicle Emissions near a Major Road." Atmospheric Environment 34:51-59. 
10 See Zhu Y, Hinds WC, Kim S and Sioutas C. 2002. “Concentration and size distribution of ultrafine particles near 
a major highway.” Journal of the Air and Waste Management Association 52: 1032–42. 
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Epidemiology and Community Health 62: 647-649.  
16 See New York City Department of Parks & Recreation, Trees Count! Street Tree Census: 
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17 City of New York Parks and Recreation. 2006. Greening Morrisania: A Community Forestry Management Plan. 
Available online: 
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18 For more information on PlaNYC and to download PlaNYC and supporting documents visit: 
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20 See New York City. 2008. Sustainable Stormwater Management, Main Report. New York, NY. Available online: 
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III. GIS Tutorial Materials 
 
Geographic Information Systems (GIS) are an important analytical tool to study land use, 
transportation and environmental quality. This tool will be very important as the 
community groups that participated in the South Bronx Environmental Health and Policy 
Study continue to work to improve environmental quality in the South Bronx beyond the 
completion date of the project. The rest of this document includes a GIS tutorial material 
that was developed by Zvia Segal Naphtali for the participating community groups so 
that their staff members can use it. A copy of GIS software and a CD containing the data 
mentioned in the tutorial will be given to each community group.  
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What is GIS? Definitions and illustrations
Examining the USGS Publication on GIS (booklet) on GIS

Website http://erg.usgs.gov/isb/pubs/gis_poster/

DISCUSSION:
"In the strictest sense, a GIS is a computer system capable of assembling, storing, manipulating, and
displaying geographically referenced information, i.e. data identified according to their locations.
Practitioners also regard the total GIS as including operating personnel and the data that go into the
system." USGS

MORE DEFINITIONS "A geographic information system (GIS) is a computer-based tool for
mapping and analyzing things that exist and events that happen on earth. GIS technology integrates
common database operations such as query and statistical analysis with the unique visualization and
geographic analysis benefits offered by maps." ESRI

"GIS is an integrated system of computer hardware, software, and trained
personnel linking topographic, demographic, utility, facility, image and other
resource data that is geographically referenced." NASA

GIS has already affected most of us in some way without us even realizing it.
Have you used an Internet mapping program to find directions? Congratulations,
you've personally used GIS. The new supermarket chain or drugstore on the corner
was probably located using GIS to determine the most effective place to meet
customer demand.

ABC of GIS; On Spatial Data Organization

Basic terminology and Introduction to the basics of
computer mapping

INTRODUCTION TO GIS
CONCEPTS AND HISTORY

"Learning GIS is much like learning to sail.
About half of the task involves learning the

constructs and vocabulary of its practitioners.
Most of the remaining learning requires

that one come aboard and try it."

Adapted from Prof. Jacob Cohen's comment on statistics
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What is GIS? http://www.gis.com/whatisgis/whatisgis.pdf

.

The following are interesting websites.

ON GIS http://www.gis.com/whatisgis
/index.html and also
http://www.esri.com/industries/k-
12/education/what_is.html and listen to
an excellent introduction to GIS at

http://gis.esri.com/esriclips/flash.cfm?path=71.

READING ABOUT GIS:

Books that introduce you to GIS via examples from different areas of
application

(1) Laura Lang, Transportation GIS (ESRI Press, 1999)

(2) Andy Mitchell, Zeroing In (ESRI Press, 1997-1998)

(3) Also go to
http://www.esri.com/mapmuseum/mapbook_gallery/volume22/
transportation6.html
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Let’s get started. Let’s make our own map.

The power of GIS is the integration of attribute data and map (graphic) data.

Attribute Data Map Data

A screen showing tabular data on crime and a map of police precincts in Brooklyn
The data includes information on type of crime, day of the week and the location where the
crime was committed and more …

In this lesson you will first learn how to create a simple map in ArcMap. Note
that you can use these same instructions to make a map with any GIS data files that
can be read by ArcGIS These are called “shape files” and they have an extension
“.shp”.

STEP 1: DOWNLOADING DATA INTO A FOLDER ON THE C: DRIVE

First, please create a folder on the “C: Drive” on your computer and name it
“C:\GIStutorial.” The data for today’s exercise is available on the accompanying CD
in a folder called “BRONX – LESSON 1.” Go ahead and copy the files for today’s
exercises from “BRONX --LESSON 1” to “C:\GIStutorial” folder on your
computer. Start by inspecting the data in the folder “BRONX --LESSON 1.” Note
that it has a number of sub-folders. For example, you should save the map files that
you will create with the data in “BRONX --LESSON 1” in the sub-folder called
“…MY MAPS” that is available under “…\BRONX -- LESSON 1.

Making a Map From A to Z
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STEP 2: Launching ArcMap and Adding Data Layers
All mapping work is done in ArcMap.

When you install ArcMap you will see this icon

Please navigate to it, click on it and you will
launch ArcMap.

When the first dialog box comes up (see on the
right) in ArcMap, make sure to start with a “A
new empty map” and press OK. [Later on when you will be returning to the map
you are about to create, you will choose the option “An existing map”].

To bring in a file into ArcMap, just click on the "plus" sign ( ) on the Standard
Toolbar (shown below), and navigate to the “C: drive” and to the folder with the data
“C:\GIStutorial\BRONX -- LESSON1” on your computer.

This is the Standard Toolbar:

There are a number of folders under “BRONX -- LESSON1”. These include
BRONX BASIC LAYERS and a number of BRONX FACILITIES & PROGRAMS
FILES. You will also see the folder “MY MAPS” where you will be saving all the
work you will complete today.

Let’s bring a few files into ArcMap. Using the Add Data dialog box, navigate to
“BRONX BASIC LAYERS”. Next, select this folder and find the file

. The file has data from the 1990 Census.

You will now see the file (or layer) appear in the Table of Contents
which is on the left side of the ArcMap interface.
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You will also see a map of the Bronx with the ZIP Codes (Note that the color of the
map will vary each time you open a map in ArcMap).

To inspect the data in this file, just right-click on
the layer “BX_zip_w_old_data” in the Table of
Contents and select “Open Attributes Table”.

STEP 3: Inspecting the Data in the file.

When you inspect the contents of this Attributes
Table you will see a field/column called
“MEDHHINC” (Median Household Income). You can sort the data in this field by
right clicking on it (in the grey area) and selecting “Sort Descending”.

What you will see on top are the ZIP
Codes with the highest Median
Household Income ($45,300 in
Riverdale) and on the bottom the
lowest ($8,607 in Mott Haven/Port
Morris).

Note about the data: In this file Hunts
Point includes Rikers Island which is
actually a part of a different ZIP Code
in Queens (11370 – Jackson Heights).

A number of other interesting fields are available in this Attributes Table. These are,
for example, Per Capita Income, Poverty Rate, Total AIDS cases and Total Pediatric
Cases of AIDS by ZIP Code. There are also two fields with total population data
from the 1990 census and the 2000 census.

There is also a field called “Shape” whose content is the word “Polygon”. This is the
field that creates the boundaries of the ZIP Codes on the map.

Table of
Contents
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STEP 4: Symbolizing Median Household Income

Coloring the ZIP Codes by data from
these various fields of data is called
“Symbolizing” or “Thematic
Mapping”. To symbolize
“MEDHHINC”, right click on the
layer “BX_zip_w_old_data” in the
Table of Contents and go to
Properties, and in the Layer Properties
window choose the Symbology Tab.

We will map the Median Household
Income (“MEDHHINC”) in each ZIP
Code using a color ramp where darker
colors represent higher incomes.

First, select to show Quantities and
Graduated Colors. Make sure to choose the
field “MEDHHINC” in the drop-down list
“Value”.

Note that ArcMap chooses the ranges for each
of the colors based on “Natural Breaks” in the
data. The Yellow to Brown color range is the
default in ArcMap. You can easily change these default
colors but for now let’s go on.

We are offered 5 Classes (ranges) that seem reasonable.
Note that I would have liked ranges such as “Under
$13,000” and so on. This time we will accept ArcMap’s
choices and go on. Click “Apply” and let us see what we
got. Interesting map, isn’t it?

However, I know that large parts of the Bronx (particularly in the north of the Bronx)
are covered with large parks and therefore this map is misleading if shown without the
parks layer. Let’s add the parks and then inspect the map and see what it looks like.
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On the main tools menu you will find

the Add Data Tool . Click on
Add Data and navigate to “BRONX
BASIC LAYERS.” Find the file
called “BX_Parks.shp”.

To change the color of the parks, click
on the patch under the
“BX_Parks.shp” layer in the Table of
Contents and change the fill color to
deep green. This map looks better,
doesn’t it?

We can now add the ZIP Codes numbers by simply right clicking on the layer

and selecting “Label Features”, as shown below:

The ZIP Code numbers will now appear on the map.

What if the ZIP Codes do not appear on the
map? Read below.

On the Table of Contents, right click on the layer
“BX_zip_w_old_data” and go to Properties. In the dialog box that opens, select the
tab “Labels”and make sure to label with the field “Name”.

The map looks better. There is one problem. The Rikers Island ZIP Code is not
10474. However, in our database Hunts Point and Rikers were combined into a
single ZIP Code. Riker’s Island is actually part of the Jackson Heights, Queens ZIP
Code. Use the Select Features tool and select Hunts Point and you will see for
yourself.
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Your next task is to prepare this first map you have made for printing.

STEP 5: Creating a Layout for Printing and
for Export to pdf.

Once you have a map you can move on and enhance it
further. The first step is to go to the Main Toolbar and
select View > Layout View.

The map will appear within a frame and in Portrait
view. Your first task is to change the view to
Landscape.

Go to File > Page and Print Setup and select
“Landscape”. Next step: Let’s edit the layout. This can be done by clicking on the
frame in the Layout View and simply stretching it to
the desired shape.

You can always see how well you did so far by
going to File > Print Preview.

ENHANCING THE LAYOUT

Now that you have the basic layout, you can add a
legend, a title, a north Arrow and more. Go to
Insert on the main tool bar and you will be offered
a number of choices.

Let’s start with a Legend. Make sure you are in the
Layout View

You insert a Legend by going to Insert on the
Main Menu and select Legend (shown on the right)
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ON LEGENDS

In the Legend Wizard you can choose which
layers to display in the Legend on your map and
also the order in which they will be displayed.
For example, if you prefer the Parks to be at the
bottom of the legend, you can change the order
now (using the up and down arrows, shown on
the right of the layer names).

The legend does not look very good at first. You
can do a few things to make it look much better.

The name of the layer can be changed (as
shown on the map on the right) and you can
add a border and some color to the legend.
Start improving the looks of the Legend. You
can add a “Border” to the Legend, add color as
background and add a drop shadow around it

You can improve the looks of the Layout in a
number of other ways:

Insert > Title
Insert > North Arrow and
Add Text and write “Prepared by …”
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The name of the layer can be changed by clicking on the name in the Table of

Contents and writing in this title: instead of
“Bronx_zip_w_old_data.”

You can also use the “Pan” Tool” to move the map a bit to the left, leaving
more room for the legend. You can make the legend wider (as shown above).

Next, please add a Title, a North Arrow and the Text “Prepared by xxx”.

THE FINAL MAP

Finally, you can improve the looks of this final map by removing the word “Legend”
(as shown below) and delete the name of the layer “MEDHHINC” in the Table of
contents. This is the way to do this: Remove the checkmark from “Show.”
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Changing the name of a layer in the
Table of Contents is easy.

Click on the name of the layer “MEDHHINC”
and just delete it. Hint: You may have to do it a
few times before you are able to delete it.

STEP 6: THE FINAL STEP
Saving your work – the “mxd” file.

The map you just prepared can be saved by going to File > Save As …” and saving it
under “BRONX -- LESSON 1 \MY MAPS” as “MY FIRST MAP.mxd.”

The “mxd” file saves just the information needed to re-create the map. You always
want to make sure that this map will open up properly if you move it elsewhere. To
achieve this, you must establish proper connection to the data that went into making
this map possible. Therefore you must save the map with a “Relative Path”.

STEP 6.1: Saving your work – the
“Relative Path”

To save with a Relative Path, please go to
File > Document Properties and fill in the
following details, as shown on the right.

If you move the “MY FIRST MAP.mxd”
file with all the data files that went into its
creation elsewhere – for example,
somewhere else on the computer in the lab
or if you copy it to a CD -- you will most
likely be able to open it. You will not have
to do all the work again!

Saving with a “Relative Path” saves you a lot
of problems. You can also save a thumbnail

image of the map.

Next, please go ahead and save your map in the folder “...MY MAPS”.
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STEP 6.2: Printing and Exporting Layouts

You can export this layout into a “pdf” file which can be brought into a PowerPoint
presentation.

Go to File > Export Map and save your map as a “pdf” file under “…\MY MAPS”

Next, navigate to the “pdf” file, click on it and you will see it in an Adobe Reader.

You can select it in the Adobe Reader using the “Snapshot Tool”.

Open a PowerPoint and paste the file from the Clipboard into the first slide. It is
really easy to do. You can also paste it into a document in MS Word. Try it now.

You are done with the first lesson. Close ArcMap.

Take notes. What have you learned so far?

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________



An example of a well-designed map
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Learning About the ArcGIS Environment (the software)

ArcMap , ArcCatalog and ArcToolbox .

 PART 1: AN OVERVIEW
Introduction to the GIS software
ArcMap, ArcCatalog and ArcToolbox

A Brief Guide to the software, GIS Concepts, Examples & Exercises

The concepts, examples and exercises you will be working with today will
introduce you to basics of working with Geographic Information Systems (GIS).
You will also learn how to conduct spatial analysis using the leading software package
– ArcGIS.

The best way to learn how to use ArcMap is to try it yourself, as we did in the
first part of this handout. In the first lesson you learned some basic ArcMap skills.
This lesson continues to show you how to create excellent looking maps and how to
save them properly.

STEP 1: Launching BOTH ArcMap and ArcCatalog.

As you just saw, all mapping work is done in ArcMap. ArcCatalog is where the data is
managed. It has a lot of features like Explorer but it is much more.

Open ArcMap and ArcCatalog using the Icon in the main menu in ArcMap.

Remember that you must navigate to the software on your computer.

Using ArcCatalog to Preview Data and Examine Metadata

Examining your data in ArcCatalog allows you to view and learn about the data sets
prior to using them in ArcMap. This is much better than inspecting your files in
Explorer, as you will see shortly. In ArcCatalog, unlike Explorer, you can also look at
the maps.
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ArcCatalog is part of the ArcGIS Desktop. Using it you can view available GIS
data sets in a catalog tree which is similar to Windows Explorer but has a number of
advantages. You can see what the data looks like using the Preview tab (see the open
ArcCatalog window below). You can examine the documentation that comes with
the data using the Metadata tab. You can also use ArcCatalog to copy, rename, move,
and delete GIS data sets. Because all GIS data layers actually consist of a group of
several files, using ArcCatalog is a better way to manage GIS data than the Windows
Explorer.

Previewing the file we just worked with is easy. Just find the file called

under “BRONX BASIC LAYERS.” Next, use the tab
“Preview” to see the map and the data by selecting to preview “Geography” or
“Table”.

“Preview” allows
you to see both the
map (Geography)
and the data
(Table).

You can also see your first map if you saved it as a thumbnail image.
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Next, you will explore the most basic functions and features of ArcCatalog. You will
continue learning about ArcCatalog as we use it in the exercises that follow.

For further information about ArcCatalog, go to Help in ArcMap.

Begin the brief tour of both ArcMap and ArcCatalog with a map
that was prepared for the following exercise. In the course of the tour, you will learn
a lot more about the ArcMap and the ArcCatalog interface.

STEP 2: Open an Existing Map Document

Go to File > Open (on the main menu
of ArcMAP), now we will “Open an
Existing Map”. Navigate to
“BRONX -- LESSON 1\
BRONX MAPS.”
Please bring in the map document called
“Bronx1.1.mxd.”

The “BRONX1.1.mxd” map document
(sometimes called “project”) will open in
ArcMap.

The map you will see shows the outlines of the borough of the Bronx, the water
around the borough, the South Bronx Study Area, the Waste Transfer Stations and
TRI Sites in the Bronx and the Bronx streets.
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ArcMap stores this map as a “map document” (.mxd) that you can redisplay, modify,
and share with others. Remember, this map document does not store the data.
It only references the data stored on your disk in various folders, along with
information about how the map should be displayed.

In ArcMap you make maps from layers of spatial data. As you will learn in the
course of these two lessons, you can choose colors and width for lines (such as
streets), symbol types (Waste Transfer Stations) and sizes for a variety of points and
colors for polygons. You can also ask questions of the data. This is called “query
attributes.” You can analyze spatial relationships. You can design maps and save map
layouts, and prepare professional looking maps that are ready for printing. Your maps,
as we have seen, can also be saved as pdf files and included in PowerPoints.

To go to Layout, please click on View on the Main Menu and select “Layout
View”. Note that the map looks different in a “Layout” view (shown on the right).
In the layout view, the map has a frame around it and, in this layout, there is also a
second small map of the Bronx.

Map view Layout view

You can customize your maps in various ways, enhance the layouts (shown above on
the right) and prepare them for printing. For example, you have already learned that
you can add a Legend (see the layout on the right), add Titles, and also a North
Arrow, and you know how to add text such as “Produced by John Doe”.

You can add information to your layout such as information about the Data Source.
You can add other annotations or a Logo, to your layout. You can also include an
“inset” sometimes called “Overview.” Please look closely at the layout view on the
right above. You can use this “Inset” to show where you are in the map when you
zoom into different parts of the Bronx on the larger map.
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DATA SOURCES: Some of the files used
in this exercise, for example the Streets and
Borough layers, were downloaded from the
NYC Department of City Planning website
under the Bytes of the Big Apple
http://www.nyc.gov/html/dcp
/html/bytes/applbyte.shtml. and also
http://www.nyc.gov/html/dcp
/html/bytes/dwndistricts.shtml

Other files were downloaded from
the New York State Department of Environmental Conservation website.
http://www.dec.ny.gov/imsmaps/facilities/viewer.htm

Please take a few minutes and examine what’s available on these websites.

.

Let’s add a title in the Layout. This is easy to do, as we have seen in the earlier
exercise. Just go to Insert >Title. In the box that appears on your map you can
write “MY FIRST MAP.”

Below I describe briefly how I designed this layout. First, I selected the map so the
frame shown above on the right is available. I pulled the frame down a bit to make
some room for the title “MY FIRST MAP”. I used the “Pan” Tool on the Tool Bar
(please find it) to move my frame down a bit. The Legend was already there. I could
have added a North Arrow – which is also available under Insert on the main menu
and a Scale.

On the right is the map display area. On the left of the ArcView display window is
the Table of Contents, showing you which geographic layers are available to display.
All the layers are displayed since the BOXES next to them are checked.

This particular map contains the following layers in the Data Frame:

Waste Transfer Stations Data from the NYC Department of Sanitation
Toxic Release Inventory Sites Data downloaded from the NYS DEC website
Bronx Streets Data from the NYC Dept. of Planning website
The South Bronx Study Area Prepared by Zvia Segal Naphtali
Water lines and regions Prepared by Zvia Segal Naphtali

STEP 3: A CLOSER LOOK AT THE LAYERS IN THE TABLE
OF CONTENTS
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YOU NEXT TASK
 Try checking and un-checking the BOXES and see what happened to the map.

Below please write down what happens when you uncheck a layer.

The streets _____________________________________________________

The Borough map _______________________________________________

The Water Regions _______________________________________________

The Study Area dissolved __________________________________________

Table of
Contents

ArcCatalog
& ArcToolbox

The Data
Frame

Step 4: Examining the Interface
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You may have noticed that there is another icon next to ArcCatalog. This is
ArcToolbox can be launched by clicking on the red Toolbox which is available on

the main toolbar next to ArcCatalog. .

A large variety of tools are available -- such as buffering a
point, line or polygon and so on. Some of these topics
will be covered in this workshop.

I teach about many of these tools in an Advanced GIS
class.

The ArcMap interface includes a number of parts. On the left is the Table of
Contents (TOC) where all the layers that you bring into ArcMap are listed. Maps are
displayed in the Data Frame. There are also a large number of tools, some of which
you already worked with in the earlier section of this document..

Standard Tool bar

Table of Contents

Showing the layers

The ArcMap Toolbar

Can be moved &
placed anywhere

The best place to dock it
is as shown on the left

Step 5: The Tools
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Next you will inspect the menus, tools and buttons more closely. Your will also work
with some of these tool in the following exercise! However, let me introduce you to
some of the most useful tools right now.

The ArcMap Tool Bar includes tools for moving around a map. This Tool Bar
can be moved and parked anywhere around the map. To repeat, I highly recommend
that you place it between the Table of Contents and the Data Frame window. Try
moving the Toolbar around now. You will explore a number of these tools in the
course of the following exercises. Let me introduce you to some of these tools now.

Please keep the tools as shown on the right.

Below I discuss some of these tools:

Zooming Tools

Fixed Zoom in and Zoom out

These three tools allow you to go back to previous views. The globe allows
you to go to the full extent of the map. The arrows take you to the previous
view and back again.

The Pan tool is used for panning a map to see different areas of the map at the
same scale.

Try moving around the map briefly. We will do this much more systematically later

on today. Using the Zoom In tool, click on the center of the South Bronx
Study Area. The map will move to the right, please bring in back to the center by

using the Pan tool. To return the map to its original size (“Full Extent”) use the

little globe ..
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Step 6. Learning More About ArcCatalog

This Identify Tool gives you information about layers on the map.

The Select features Tool

IN SUMMARY: When you place your cursor on each of the tools, you will see their
names. There is also an Editor Tool Bar. When you activate it, you can use it to
create New Features (e.g., a new park) on your map or reshape the features. There is
also a Drawing Tool Bar that allows you to add text and labels to your maps.

As discussed above, ArcCatalog can be activated from the Icon inside of ArcMap.

What do you see in the catalog tree? The catalog tree on the left side of the
ArcCatalog window looks similar to a standard Windows Explorer, but the
ArcCatalog tree only shows data that can be read by ArcGIS (e.g., files with an

extension “*.shp”). [Note that Excel
files can be also brought into ArcCatalog
and can be previewed in ArcCatalog].

After you open ArcCatalog, please navigate to the
data on in “BRONX --LESSON1\BRONX
BASIC LAYERS” and have a look at the files.
For example, click on the button “Preview” and
navigate to the file called “BX_BORO.”

Examine this layer. The Tab on the bottom dropdown list indicates that we are
looking at “Geography”. You should also examine this file looking at it as a “Table”.

Next, you should also have a look at “BX_STREETS_LION”.
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Previewing Attribute Tables in ArcCatalog:

What is the name of the file on the right?

Can you find it?

What can you find out about this file?

Under Preview, you can look at “Geography” or a
“Table”. Please preview the attribute table (table of
associated tabular information for a GIS data layer) by
choosing “Table”. This shows all the records in the GIS
layer.

Scroll down and across the Attributes Table to see all the
fields in the table. Can you find the file shown in the right?

IMPORTANT NOTE:

A file ending in “xxx.shp” is called shape file. This is a very
common GIS data format, created and used by ESRI, the makers of ArcGIS. A shape
file actually consists of several files. You can see all these files if you look at the GIS
data folders you are working with in Windows Explorer. Try it now! All these files
are necessary for a shape file to be read by ArcGIS. As noted earlier, ArcCatalog is a
better program than Windows Explorer for managing GIS data because it makes
copying or renaming data easier. If you copy a shape file in ArcCatalog to another
folder, the ArcCatalog program knows to copy all the associated data files with it.
Therefore, this is the best way to copy GIS files.

ON METADATA

Metadata is data about data. Below is an example. Click on the metadata tab for the
file called “BRONX --LESSON1\BRONX BASIC
LAYERS\BX_STREETS_LION.shp.” When the metadata appears, you should see
three more tabs - Description, Spatial, and Attributes.
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The first tab, Description, should
have some general information.

Note that no such information is
available for this file.

Next, click on Spatial Tab and you will see the following:

Horizontal coordinate system

Projected coordinate system name:

NAD_1983_StatePlane_New_York_Long_Island_FIPS_3104_Feet

Geographic coordinate system name: GCS_North_American_1983

NOTE: This is the projection usually used for New York City.

Finally, let’s examine the Attributes. This is a data dictionary for this shape file.
It can contain important information about the fields in the Attribute Table.

Finally, please look at another file called “BX_roads.shp”. What did you find out
about this file?

Go back to ArcMap for the next exercise.

Before you start the next exercise, unselect the
“WTS_Geocoded (the Waste Transfer Stations) and the
“BX_TRI_Sites” layers in the Table of Contents.

Next, using the Zoom In Tool
zoom into the South Bronx

There are a large number of layers in the folder
“BRONX BASIC LAYERS.” Start adding some
layers. Add the subway lines, subway transfers,
and the subway stations map layers.

Step 7. A Brief Introduction to Mapping Roads, Highways
and Subways in the South Bronx.
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SYMBOLIZING LAYERS
Click on the Icon under the layer

For the “Subway Routes” select this “Mass Transit Symbol” (if available)

Next, in the Symbol Selector window, in the
“Options” small panel on the right side of the
select the following:

Select size 8 and red for the symbol of the
“BX_SUBWAY_ ROUTES.” Next, click on the
layer “BX_SUBWAY_STATIONS” and select
the following symbol -- a circle size “4” and also
red.

Your next step is to label the Subway Routes (and the stations).

Right click on the layer “Subway Routes” and go to
Label Features. Later you will add labels to the
Subway Stations in the same way.

NOTE: I recommend
that you experiment and
choose your own symbols
and colors.
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Not all “Subway Routes” will be labeled so use the Label Tool to add the missing
labels.

Where do you find the Label Tool? Find the Drawing Toolbar (shown
below on the right)  Instruct ArcMap to “Automatically
find the best placement” for the labels.

Click on the “A” and you will be
offered a number of choices. You
can use the Label Tool

Select the option to “Automatically find the best placement”

Place some labels, and look at the results. Note: make sure you
are placing labels on the Subway Line and not the streets. If a
street gets labeled, just select the label with the
“Select Elements” Tool and delete the label.

Take Some Notes:

________________________________________________

Here is the map with the labels

I added. Next, please label some of the
subway stations.

Right click on the layer
“BX_Subway_Stations”

and go to “Label Features”

But you will notice that the map gets too crowded so
perhaps it is not a good idea unless you zoom much
closer to some area, for example, Hunts Point. Let us
zoom into Hunts Point.

But there really are no subways in Hunts Point.
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Please zoom in next to Mott Haven or some other area in the South Bronx.

It is much easier now to look at the subways
and the subway stations in this area of the
Bronx.

Now bring in the bus lines and label them as
we just learned.

But first change the symbol of the bus line
and “unselect” the Subway routes. [Note:
Your map will be much too crowded if you
don’t do this first].

You may continue on your own now.

Experiment and learn more about
transportation in the Mott Haven
area of the Bronx or elsewhere.

One More Map.

Next, I would like you to unselect the subways and the buses.

Have a look at the highways that cross the Bronx. Add labels.

Please list the highways you see on the
map on the right.

______________________________

______________________________

______________________________

______________________________
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Next, you will learn about the attributes of various polygons and lines (the Bronx map
or the Study Area) and the lines (streets, subways, buses, highways, etc.).

Please start with the
layer Subway Routes.

Take notes on what
you see. On the right is
the Attributes Table of
“BX_Subway_Routes”.

The field that makes this
file mappable is “Shape.”

The labels we just placed
on various subway routes came from the field “Name”. [You could try using “Route”
or “Label” and see what happens].

The field “Shape_len” is the length of the particular segment of the route.

HOW LONG IS THE IRT PELHAM NO. 6 SUBWAY LINE IN
THE BRONX?

Try and measure the length of the entire line. You can use the Measure Tool (on the
Tools Bar) and trace the line, try it!

To be more precise you can do the
following:

Go to Selection > Select by Attributes
and in the dialog box make the following
selections. NOTE: make sure that the
layer from which you are selecting is
“BX_Subway_Routes”. Select the field
“Route” = ‘6’.

After you click “Apply” you will see that
the route has been selected (its color will
change into cyan).
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Next, open the Attributes Table.

If you want to see only the selected segments of the No. 6 Line, you should click on
the button “Show” (on the bottom of the table) and next on “Selected” and you will
see that 18 of the 72 segments were selected.

You can find out the length of the No. 6 Subway line in the Bronx by right clicking
on the Title of the column
“Shape_len” and selecting
“Statistics.”

The length of the No. 6 subway line in the Bronx is 40871.542245 feet which is
7.7 Miles (5,280 feet = 1 Mile).

Please open the Attribute Table for the Subway Stations and inspect the fields.

Open the Attribute Table for the Bronx Highways. Note that there is no field
indicating the length of the highway segment.
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You can calculate this information but first you need a
column/field to hold the results. Click on the Options
button (on the lower right side of the table shown above).
Select Add Fields and in the window that opens name the
field and add information about what type of field it is.

We use Float because
the field Length will have
decimals.

Click OK.

You will see a new column
at the right end side of the Table and it is filled with “0”.
Next you will calculate the Length of each segment in the Bronx table of highways.
Right click on the new field you created called “Length” and go to “Calculate
Geometry.”

Select “Miles”. Click OK.

Inspect the Table.

You can calculate
the length of the
Bronx River Parkway,
in the same way, for example.

Hint: select all segments of the
Bronx River Parkway Using
Selection > Select by
Attributes. Next, right click
on the new column “Length”
and select “Statistics.”

Here
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Step 9: ADDING MORE LAYERS & CHANGING COLORS

Take some notes on what you found out.

_________________________________________________________________

____________________________________

____________________________________

____________________________________

On your own, just turn layers on and off and inspect the results.

Save your work in an “mxd” and don’t forget to save with a Relative path.

Call this mxd “Mapping Transportation in the Bronx.mxd”. Save your work in the
folder called “MY MAPS”.

Let’s review briefly what we have learned so far.

If you turn off the layer called “BX_TRI_SITES”, (remove the check mark in the box
next to it in the Table of Contents) both the symbols and the labels will no longer be
visible. If you turn off the layer “BX_WATER_REGION_fixed” layer the map will
look very different.

Now ADD A LAYER, and see what your map looks like. Please use the

ADD DATA button on the main Toolbar and navigate to “BRONX --
LESSON 1\BRONX BASIC LAYERS” and bring in “BX_Parks.shp.”

STEP 8: Turning Layers On and Off (Revisited)
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You will see polygons (regions) appear on the map
with some random color chosen by ArcMap.

Please click on the patch under “BX_Parks” and
select a deep green color in the Symbol Selector
Window that will open. Inspect the map and you
will see all the Parks on the map.

Click and hold the left mouse button on the Parks
Layer and drag it to the top of the Table of
Contents.

You can name the Parks by right clicking on the layer and selecting “Label Features”.
You will see labels on all the Parks. Next remove the labels by unselecting “Label
Features”.

If you click on the “arrow” next to the button “A”
(shown above), you will find a number of tools,
including a Label Tool that you used earlier.

Use this label tool to label the
parks. So you see, labels can be
added in another way.

Please turn off the park layer for now.

You can also place the label “South Bronx” on the map using the Label Tool. You
already know how to find the Label Tool on the bottom left hand side of the Data
Frame. You can use the New Text (“A”) Tool to place a text box anywhere on your
map. After you write in it the text you wish you can move it anywhere you wish. Try
using it to write a second “THE SOUTH BRONX” label. You can add the Parks on
your map and label them.

Step 10: Adding Labels to the Parks Layer
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You can now use the Select Elements Tool to move any text you write
anywhere on your map. Look where I moved the South Bronx title. Finally you can
use the Label Tool (shown on the right) to place a label on the Jerome Park Reservoir

ON YOUR OWN: Use the Label Tool to add more labels on the map. Write down
the names of the places you added labels to.

Turn on the parks! If they are no
longer on your map, please bring
them back in.

Click on the Zoom in
button. Click and hold down the
mouse button on a point above
and to left of the South Bronx
Study Area. Drag the mouse below
and to the right of the South Bronx
Study Area and release the mouse
button. This can be tricky
sometimes.

An alternative way is to click on the screen to zoom in, centered on the point that you
clicked. This requires a number of steps.

Next try out the following Tools to explore the map.

Zooming Tools

STEP 11: ZOOMING AND PANNING

Here
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Fixed Zoom in and Zoom out

These three tools allow you to go back to previous views. The globe allows
you to go to the full extent of the map. The arrows take you to the
previous view and back again

.
Place your cursor on each of the tools and you will see their names.

The Pan tool is used for panning a map to see different areas of the map at the
same scale.

When you are done use the Globe Tool (Full Extent) to go back to the full map.

You will find creating Bookmarks very useful.

Zoom to the South Bronx. On the main menu click
on Bookmarks > Create.

A spatial Bookmark Window will open. In the
Bookmark Name box write “South Bronx”.
Click OK.

Click on the main menu View > Zoom Data > Full Extent. It is an alternative to
using the Globe Tool or Full Extent. Next click on Bookmarks and select “SOUTH
BRONX”. Create a few other Bookmarks to areas of interest to you. Zoom in to
“St Mary’s Park.” [If the parks are not labeled, please label them now] From now on,
each time you want to get the South Bronx, it requires just one step.

STEP 12: USING THE SPATIAL BOOKMARK
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STEP 13: MEASURING DISTANCES

The measure tool proved very useful to me when I
worked on a case study that involved preparing an
emergency plan and I needed to measure distances
to the nearest hospital or fire house.

Click the Measure Tool on the Toolbar

A dialog box with a number of options will open up.

The simplest thing to do this is to measure a distance is
to draw a line and select the measurement units. Here is
an example. Let us use Miles

A Scenario (invented for this exercise): Suppose there was a spill at the Dexter
Chemical Corporation. Workers had to be taken to the hospital. Which of the two
hospitals is closer? [I am ignoring other considerations such as transportation, etc. ]

Please bring into ArcMap one more layer. Go to “…\BRONX – LESSON
1\BRONX FACILITIES AND PROGRAMS” and find the layer “BX_Hospitals”.

Add the Hospitals symbol . Make sure to zoom into this area and to add the
Facility name.
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Make sure that you are labeling with the
“Facility_N” (Facility Name). Go to
Properties and selecting the Tab “Labels”.

You must make sure that we select the
proper units for measuring a distance.

Make sure to click on the down-arrow.
Select the measurement unit for distance in
FEET.

You can now use the Measure Tool (shown on the right) and
measure and write down the distances from the chemical facility
“Dexter Chemical Corporation” to these two hospitals.

BRONX-LEBANON HOSPITAL CENTER _________________
LINCOLN MEDICAL & MENTAL CENTER _________________

Next, use the Measure Tool to measure the distance
between the T. J. Ronan Paint Company and St. Mary’s
Park.

Note: You start with the Paint Company and drag the mouse to the edge of the Park
and double-click. Write down the resulting distance ________________________

Next Measure the park itself.
This time we will be using “Measure a Feature”
which is selected by clicking on the “+” sign.

First use the “x” to reset the properties of the
Measure Tool. Don’t forget to select the units of
measurement. Write down the results _____________________________

NOTE: Don’t worry if this does not work. This is a new Tool in ArcMap and is still
not stable or easy to use.
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STEP 14: LABELING HUNTS POINT

One of the layers in your map is a streets layer.
I made the lines of the streets a light grey color so
the streets do not overwhelm the map. It is best to
see the streets only when you zoom into a particular
area on your map. For example, zoom into the area
of the Bronx called “Hunts Point”.

Using the “A” label Tool, please place a label on
this area.

Next, click on the label, go to
“Symbol Selector”
and pick the style shown below.

Note that the area is crowded with the TRI
Sites symbols and if the label was placed on the
area itself it will cover these TRI Sites, the
streets and other features.

You can now place some street names as you
move in closer to the area of Hunts Point. To
do this, please select the layer called
“BX_Streets_LION”on the Table of Contents
and right click and select “Label Features.”
You will see street labels appear on your map.

IMPORTANT NOTE: If you don’t get street names. Right click on the
“BX_Streets_LION” layer and go to Properties and in the Layer Properties window
select the tab “LABELS” and make sure the streets are labeled with “STREET”
rather than “SNAME”. “STREET” is the field where the labels are stored.
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STEP 15: ZOOMING INTO THE STREETS

Examine the map and see what the labels look like.

Next, return to a full view of the Bronx using the Globe Tool (Called “Full Extent”).
Change the color of the streets to dark black.

The streets now overwhelm the map.

SETTING THE SCALE
We can set the Streets layer to display only when the
number in the scale box is 50,000 or less. You will
find the Map Scale on the main tool bar.

To set the scale, right
click on the streets layer

in the Table of Contents and go to Layer Properties

> General Tab.

Click on “Don’t Show layer when
zoomed” and add the number “50000”.

Click Apply and next OK.

Go back to the map, zoom into Hunts
Point, and see the results. Now if you look
at the full extent (the map of the entire
Bronx) you will no longer see the streets.

This is what the map looks like when zoomed
to
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STEP 16: Finding a street address

This is what the map looks like when zoomed

to

Note that below a scale of 1:50,000 the streets
will show.

Check above, we asked ArcMap “Don’t Show layer when zoomed out beyond” and
set the number “1:50,000”.

Experiment and zoom to different scales! Each time check and see what your map
scale is. Write down what you found out.

_________________________________________________________________

Notice that when you return to the full scale of the map (the entire Bronx), the Streets
layer checkbox on the Table of Contents will be grayed out.

When the streets are visible in the map, the box is no longer grayed out in the Table
of Contents.

You will now learn to use the Find tool that is available on the Toolbar to locate
a specific street by name. Click the Find Tool. The Find dialog opens. Make sure to
click on the “Features” tab.
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In the Find field, shown above, type “Bay”.
Click the dropdown arrow next to "In" and
choose “BX_STREETS_LION”.

After the Street was found, you can use the
“Flash Feature” to see where the street is.
Next, right click on a number of segments of
the street and use “Flash”

You can also select “Identify Results” and get
all the information on this street.

This tool is useful when you are looking for particular hospitals or schools and
want to learn more about them or find them easily!

Using the Find Tool, continue exploring the
Find Tool

Write some notes on what your learned.

_______________________________________

_______________________________________

We already had an opportunity to learn how to change the display symbol for
Hospitals. When you bring a new layer into the Table of Contents (on the left panel)
you can choose from the variety of symbols one that is suitable for the particular
layer.

STEP 17: Changing the Display Symbol
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If you go to “…\BRONX --LESSON 1\BRONX FACILITIES & PROGRAMS”
you will find a number of files or layers that can be added to our map. Add the
“BX_PUBLIC _ELEM_SCHL.shp” layer. Next, change the Symbol or icon that will
show on our map.

I want you to find the symbol shown on the right.
You can decide on its size and color. You will see
the effect of your choices on your map

Please change the color and size as well.

Clearly there are not too many schools in the Hunts Point
area. There is only one school that I can see in Hunts Point
on the map below. Please look for Schools in other areas of
the South Bronx. SEE THE MAP ON THE LEFT.

.

To see the hospitals, as well as the schools,
you must zoom out a bit. However, we
can no longer see the streets.

If you find the hospital symbols too large,
you can easily change their size. Click on
the Symbol again and in the Symbol
Selector window go to the Options and
change the symbol size from 18 to 12. Inspect your map.
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LEARNING MORE ABOUT THE HOSPITALS AND SCHOOLS
IN THE SOUTH BRONX.

You can use the tool to learn more about the hospitals. Let us examine the
three Hospitals in the South Bronx, starting with the one near the Clay-Park Lab.
Please click on it with the Identify Tool and see what information we have.

There is a lot of information here! There is the name and location of the hospital,
capacity is 401 beds, you also have information on what census tract it is in, police
precinct, etc.

If you now use the same Identify Tool, you can look at the Toxic Inventory site
adjacent to it – the Clay-Park Lab and learn more about it.

Next get some information about the two other hospitals in the South Bronx Study
Area.

Try using the Find Tool to locate another hospital of your choice, also use the

Flash and Identify Tool to learn more
about the hospital.

You can find out
more about the Waste
Transfer stations in
the South Bronx
Study area.

The first one I looked
at is the one next to S
& S Industries, Inc. I
saw that it’s type is
“Fill Waste”

and I have an exact address.
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Please spend some more time investigating the various layers on your map using the
Flash and Identify Tools.

Now it is Your Turn.

Find the same kind of information about
the ELEMENTARY SCHOOLS OR
NURSING HOMES, ETC and write it
down.

Finally, please bring one more or more layers from
“\BRONX -- LESSON 1\BRONX FACILITIES AND PROGRAMS\”.

Try and change their symbols, color, and pick an appropriate size.

There is another way to learn about the data in these various layers.

Right click on the Hospitals layer and open the Attributes Table. At the bottom of the
table you will see that there are 13 hospitals in the Bronx, you will see their names and
that they are in various Community Districts, and more.

First sort the field called “CD_DECODE” by right clicking on the field and selecting
the Ascending option.

STEP 18: Inspecting Attributes Tables.
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JUST READ THE NEXT FEW PAGES!

Next, use the Select Features Tool to select the hospital in Community
District 1.

Check your map and you will see that the hospital
near the S & S Industries turned Cyan. Inspect the
attributes table and click on the button “Selected”
and you will see this hospital and all the
information (data) about it.

Repeat this exercise with other hospitals.

There is nothing to save.

You can, however, save the “mxd” with a name of your choice under “BRONX
– LESSON 1\MY MAPS”.

Close ArcMap and ArcCatalog. Take a short break.

The Vector Data Model

Locations such as the address of a customer, a school, a hospital, a Waste Transfer
Station or the spot where a crime was committed are represented in maps as points
having a pair of geographic coordinates (for example, longitude and latitude).

Lines, such as streets, subways, buses or highways are represented as a series of
points. Polygons are regions defined by borders (lines) which enclose an area. The
Bronx is a polygon and so is the area “The south Bronx.” Polygons can be legally
defined, such as a parcel of land or administrative areas, or counties, police precincts,
election districts. They can be naturally occurring boundaries, such as lakes,
watersheds, islands, etc.

ON VECTOR AND RASTER MAPS



LESSON 1.2____________________ Mapping in Layers

47

Copyright © 2009 Resource Mobilization Inc.

The vector data model uses points, lines and polygons to represent features. Each
feature is represented as a row in a table, and feature shapes are defined by x,y
locations in space (the GIS connects the dots to draw lines and
outlines).

The electric utility map (on the right) uses points, lines, and

polygons to represent buildings, streets, and electrical facilities.

When you analyze vector data, much of your analysis involves
working with (summarizing) the attributes in the layer's data
tables.

The Raster Data Model

The raster data model represents features as a matrix of cells in
continuous space, much like digital photographs or a television
image.

The example on the right is a raster image. See other examples

on the ESRI website.

IMPORTANT NOTE: Most of the materials we will be
working with in this workshop will involve Vector data and
very rarely with Raster data.

ArcGIS: a vector and raster approach?

Raster images can be displayed and overlaid
with vector displays containing additional
information, such as street maps and locations
of Waste Transfer Stations, on top of the raster
image. It can also be used to display non-map
images (such as a picture of house, a floor plan,
a person's picture, etc.) which may be of
interest in connection with the map.

Map layers are like transparencies that are stacked on top of each other, each layer
containing aspects of the whole map. A geographic file usually contains more
than one layer as you have already seen today.
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Map Layers

One way to think about layers in ArcGIS is to think of each table of data that we have
as a layer. These layers are similar to transparencies with each consisting of different
aspects of a map. By laying these transparencies one on top of the other, you begin to
build a complete map. To process multi-layered maps,
ArcGIS requires the layers be displayed
on a single map.

The layers can also be years or floors in a
building.

The two basic data models that ArcGIS uses
are, as discussed above, vector and raster
models.

Below are some examples of raster images for the South Bronx.

They are Aerial Photographs of the South Bronx.

Throughout the exercises you just completed, you worked with vector data.
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Let’s summarize: Unlike the Aerial Photography maps shown above, the maps you
worked with in this handout were all Vector maps. Vector data models represent
geographic phenomena with points, lines, and polygons. The file format used in
ArcMap for points, lines, and polygons is the “Shape” file.

Shape files, as we have seen, include streets, subways, highways, etc. We also worked
with point data including hospitals, elementary schools, police stations, nursing
homes, firehouses, landmarks. Some of these can be points or polygons. For example
parks and playgrounds can be represented either as points or polygons. Polygons
include ZIP Codes, and Census 2000 tracts, census blocks and block groups (next
class you will learn about these polygons).

We can also bring into ArcMap tabular data in dBase or ACCESS files. NOTE:
However, to map the data in them, they have to be connected (or joined) to
appropriate shapefiles.

To Summarize
Shapefiles include Points, Lines and Regions

All these layers are part of a borough’s database. Each layer contains one type of
feature. In today’s LESSONS, we are working with a small number of shapefiles for
the Bronx to produce some of the Final Map discussed above.
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I HOPE YOU LEARNED TO APPRECIATE THE POWER OF GIS!

I suggest that when you finish working on this handout you should go to the
following websites and learn more about GIS and about ArcMap.

See web site: http://gislounge.com/library/introgis.shtml

You will find additional introductory materials on
The ESRI website “GIS.com”

http://www.gis.com/index.html

Watch the DEMOS
On the same website, watch the demos.


	Funded with a Congressional Appropriation sponsored by Congressman José E. Serrano and administered through the U.S. Environmental Protection Agency

